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Warranty Statement

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT
TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, AGILENT DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED WITH REGARD TO THIS MANUAL AND
ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. AGILENT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL

OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT OR ANY INFORMATION CONTAINED HEREIN.
SHOULD AGILENT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH
WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT
WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL
CONTROL.

DFARS/Restricted Rights Notice

If software is for use in the performance of a U.S. Government prime contract or
subcontract, Software is delivered and licensed as “Commercial computer software” as
defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR
2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or
any equivalent agency regulation or contract clause. Use, duplication or disclosure of
Software is subject to Agilent Technologies’ standard commercial license terms, and
non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users
will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or
DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.




Safety Notes

The following safety notes are used throughout this document. Familiarize yourself with
each of these notes and its meaning before performing any of the procedures in this
document.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if
not correctly performed or adhered to, could result in injury or loss
of life. Do not proceed beyond a warning note until the indicated
conditions are fully understood and met.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not
correctly performed or adhered to, could result in damage to or destruction of
the instrument. Do not proceed beyond a caution sign until the indicated
conditions are fully understood and met.

Definitions

e Specifications describe the performance of parameters covered by the product warranty
(temperature 0 to 40 °C, unless otherwise noted.)

¢ Typical describes additional product performance information that is not covered by the
product warranty. It is performance beyond specification that 80% of the units exhibit
with a 95% confidence level over the temperature range 20 to 30 °C. Typical
performance does not include measurement uncertainty.

¢ Nominal values indicate expected performance or describe product performance that is
useful in the application of the product, but is not covered by the product warranty.

e Characteristic Performance describes performance parameter that the product is
expected to meet before it leaves the factory, but is not verified in the field and is not
covered by the product warranty. A characteristic includes the same guard bands as a
specification.







Contents

U3042AE16
Introduction . . ... ... ... e 2
Description . ... .. 3
Network Analyzer Requirements. . ............. . . . e 3
Verifying the Shipment. . . ... ... .. . . e 3
Available Options . . .. ... e 4
Interface Option . ... ... .. e e 4
Mounting Kits . .. ... 4
General Specifications . .. ... ... 5
Power Requirements . ............. ... 5
Environmental Requirements .. .......... .. . . . . . . . 6
Maximum Power Levels . . . ... .. e 7
Typical Reflection Tracking . .......... .. e e e 8
Front and Rear Panel Features. ... ..... ... ... .. . . . i 9
System Setup with NB242A . .. ... . 12
Preparing the N5242A Network Analyzer. . ... ... ... ... .. .. . . ... 12
N5242A RF Interface Cable Connections . ............. .. ... 15
Controlling the U3042AE16 with N5242A .. ... ... . . . . . . . e 17
N5242A Multiport Mode for Option 551 .. .. ... ... .. . e 17
Sweep Setup for Multiport and Standalone PNA-X Modes . ........................ 21
N-Port Calibration with N5242A .. ... .. . ... . e e 22
N5242A Interface Control. . . ... .. . . e 25
N5242A GPIB Control . ... ..o e e e 29
DUT Control Lines. . ... ..ot e e et et e 32
Setting the DUT Control Interface ........... ... .. ... . . . . . ... 32
Setting the Variable Source Voltage. . .. ........... ... . ... 34
Connecting to the DUT Control Lines . . ... ... ... . e 34
Using an External Power Supply. .. ... e 35
Test Set I/O Interface Commands . . ......... ottt e 37
Switch Address and Data .. ........ ... . . . i e e 37
Operational Check . .. ... . . e e e e e 40
Verification Limits .. ... .. e 40
Equipment Required. . . ... .. . e 41
Operational Check Procedure ............. .. . . . .. 42
Troubleshooting Operational Check Failures .............. ... ... ... ... .. .. ....... 48
Interconnect Cable Verification .. ......... ... . .. i 48
Service Information . .. ... ... . e 49
Replaceable Parts .. ... ... e 49
Theory of Operation . ......... ... ...t e e e e 52
RF Coupler/Bridges. . . . ... e 52
RF Switch Components. . .. ....... .. .. e 52
Source and Receiver Switch Paths. .......... ... . ... .. . . .. .. . .. .. 52
Troubleshooting the Test Set. . . ... ... . . e 54
Fanisnot Operating. ... ... .. e e e e 54
Front Panel LEDs (R, S or Active) are not Illuminated . ........................... 56
Test Ports are not Switching .. ....... ... ... . . . . . . 56
Source and Receiver Path Test .. ....... ... .. .. . . . . 57
Equipment Required. . . ... .. . e 57
Equipment Setup . ... ... e 57

Contents-1



Contents

Source Path Trace . ........ ... e e e e 58
Receiver Path Trace . .. ... ... . e e e e 61
RF Performance Fails ... ... ... . . . e 64
Control Lines are not Working . ........... .. i 64
Troubleshooting Diagrams and Tables . .. .......... ... ... . . . ... 65
Safety and Regulatory Information . ......... ... ... .. . .. . . . . . . . . .. 68
Introduction . . ... ... ... . e 68
Safety Earth Ground . . ........ .. ... . . . 68
Declaration of Conformity . . ... ... ... ... . . . i e 68
Statement of Compliance. . . ... ... 68
Before Applying Power. . . .. ... ... e 69
T3 74 U8 = 70
Electrostatic Discharge Protection. .. ... ... ... .. . . . . . . . . i 71
Regulatory Information .......... ... . . . . . . . . . e 72
Instrument Markings. . . ... ... 72
Agilent Support, Services, and Assistance. . ... .......... ... 74
Service and Support Options. . . ... 74
Contacting Agilent . . . ... ... .. 74
Shipping Your Product to Agilent for Service or Repair ............................ 74

Contents-2



U3042AKE16

User’s and Service Guide U3042-90012



U3042AE16 Introduction

Introduction

This document describes how to use and service the U3042AE16 Multiport Extension Test
Set with the Agilent 4-Port N5242A PNA-X for a 20-Port Network Analyzer solution.

Figure1 Front Panel N5242A with U3042AE16
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U3042AE16 Description

Description

The Agilent U3042AE16 is a 16-Port solid-state extension Test Set. The Test Set can be
combined with a 4-Port N5242A (10 MHz to 26.5 GHz) PNA-X Network Analyzer through
the front panel source outputs, receiver inputs and coupler access ports. With Option 551
in the PNA-X the analyzer provides a 20-Port calibration and full cross bar measurement
capability.

The U3042AE16 is directly controlled by the network analyzer, no external personal
computer or software is required.

The N5242A PNA-X Network Analyzer’s will be referred to throughout this document as
the PNA-X. The U3042AE16 will be referred to as the Test Set.

Network Analyzer Requirements

¢ The network analyzer requires Option 551 (for N-Port error correction and multiport
measurement capability).

e The N5242A PNA-X requires Option 400 to provide the test set interface connections
and requires test set file u3042ael16_pnax_p4.tsx

The test set file must be installed into the PNA-X file directory:
c:\Program Files\Agilent\Network Analyzer \testsets

e PNA-X Multiport Mode firmware revision:
N5242A Option 551 > A.09.22.07

More PNA information is available on the following websites:

¢ Documentation - http:/www.agilent.com/find/pna
¢ Network Analyzer Firmware - http:/na.tm.agilent.com/pna/firmware/firmware.htm

e U3042AE16 Test Set Files - http:/na.tm.agilent.com/multiport (see test set files)

Verifying the Shipment

To verify the contents shipped with your product, refer to the “Box Content List” included
with the shipment.

Inspect the shipment. Keep the shipping container and packaging material until you have
inspected the contents of the shipment for completeness and have verified the instrument
mechanically and electrically. If there is physical damage refer to “Contacting Agilent” on
page 74. Keep the damaged shipping materials (if any) for inspection by the carrier and an
Agilent Technologies representative.
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U3042AE16 Available Options

Available Options

Interface Option
The available Test Set cable options:
e U3021PX3 Option 442 (connects the 4-Port N5242A to the Test Set)

Mounting Kits
Available Test Set cable options:

e U3021M Option 042 (Locking links for the Test Set to the N5242A, can be order
separately).

e U3042AE16-1CP, Front Handle Kit (5063-9229)
e U3042AE16-1CM, Rack Mount Kit without Handles (5063-9216)
e U3042AE16-1CN, Rack Mount Kit with Handles (5063-9236)
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U3042AE16 General Specifications

General Specifications

Specifications for the Test Set (10 MHz to 26.5 GHz) are characteristic for the system
performance of the PNA-X and the Test Set. Before using the PNA-X and Test Set a
calibration is recommended for best measurement performance. Actual performance of the
system is based on the customer’s PNA-X and options that are used with the Test Set. A
functional certificate is only offered for the Test Set.

When connected to a PNA-X, this Test Set will degrade the performance at the test ports.
The internal switch paths reduce test port power and power to the receivers. This affects
the test port power of the PNA-X and also reduces dynamic range. The reflection tracking
values measured in the “Operational Check” on page 40 can be subtracted from the
analyzers dynamic range to determine the approximate performance of the system.

Power Requirements
Verify that the required ac power is available before installing the Test Set to the PNA-X.
e 100/120/220/240 VAC (50/60Hz)

¢ The instruments can operate with mains supply voltage fluctuations up to + 10% of
the nominal voltage.

¢ Air conditioning equipment (or other motor—operated equipment) should not be placed
on the same ac line that powers the Test Set and PNA-X.

¢ Table 1 contains the maximum wattage for all instruments. This table can be use to
determine the electrical and cooling requirements.

Table 1 Power Requirements
Instrument Maximum
Wattage
N5242A 450
U3042AE16 350

WARNING This is a Safety Class I product (provided with a protective earthing
ground incorporated in the power cord). The mains plug shall be
inserted only into a socket outlet provided with a protective earth
contact. Any interruption of the protective conductor inside or
outside the instrument is likely to make the instrument dangerous.
Intentional interruption is prohibited.

User’s and Service Guide U3042-90012 5



U3042AE16 General Specifications

Environmental Requirements

Refer to the PNA-X series standard documentation for environmental requirements.

Environmental Tests

The Test Set complies with all applicable safety and regulatory requirements for the
intended location of use.

¢ Operating Environment (Indoor Use)
e Temperature (0 to 40 °C)

¢ Pressure Altitude (Operation)
3,000 meters (~10,000 feet)

¢ The instrument can safely operate in a relative humidity of 80% for temperatures to
31 degrees C, decreasing linearly to 50% relative humidity at 40 degrees C.
Equipment Heating and Cooling

If necessary, install air conditioning and heating to maintain the ambient temperature
within the appropriate range. Air conditioning capacity must be consistent with the BTU
ratings given in Table 1.

CAUTION Ventilation Requirements: When installing the instrument in a cabinet, the
convection into and out of the instrument must not be restricted. The ambient
temperature (outside the cabinet) must be less than the maximum operating
temperature of the instrument by 4 °C for every 100 watts dissipated in the
cabinet. If the total power dissipated in the cabinet is greater than 800 watts,
forced convection must be used.

Required Conditions for Accuracy Enhanced Measurement

Accuracy—enhanced (error—corrected) measurements require the ambient temperature of
the PNA-X and Test Set to be maintained within + 1 °C of the ambient temperature at
calibration.

Dimensions and Space Requirements

Standard installation of the Test Set and PNA-X includes configuration and installation on
a customer provided lab bench or table top of adequate size and strength. For weight,
dimensions and space requirements, refer to the network analyzer documentation that is
used to configure the Test Set.

Table 2 Instrument Dimensions

Model Weight Height Width Depth

U3042AE16 15 kg (30.8 1b) 23.2 cm 42.9 cm 52.4 cm
(9.11in) (16.8 in) (20.6 in)
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U3042AE16

Maximum Power Levels

General Specifications

CAUTION It is recommended that you do not operate components near damage levels
(+27 dBm). The power levels must be 3 dB below maximum level to ensure no

damage, see Table 3.

Table 3 Power Levels

Maximum U3042AE16 Test Port RF Power Levels:

PORT 5-20 +27 dBm 0 Vdc
Maximum U3042AE16 Access Ports:

SOURCE OUT +20 dBm 0 Vdc
CPLR ARM +20 dbm 0 Vdc
CPLR THRU +20 dBm 0 Vdc
RCVR OUT +20 dBm 0 Vdc

NOISE SOURCE IN/OUT

+20 dBm 0 Vde

NOTE Refer to your PNA-X specifications to determine the maximum input power
levels for the access and test ports, or to optimize the power levels in the
receivers.

NOTE Damage and maximum levels are not necessarily the optimum level.
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UB042AE16 Typical Reflection Tracking

Typical Reflection Tracking

Specifications for the Test Set are typical. System performance for the PNA-X and Test Set
are only characteristic and are intended as non-warranted information.

NOTE Typical specifications are based on 1 to 2 units performance. Refer to Table 4
below, and Table 9 on page 40.

Table 4 Typical Reflection Tracking

Frequency Ports 1 -4 Ports 5 - 20
10 MHz to 50 MHz! —4 +21
50 MHz to 500 MHz! =5 -5
500 MHz to 3.2 GHz -7 -13
3.2 GHz to 10 GHz -12 -18
10 GHz to 16 GHz -15 -24
16 GHz to 20 GHz -17 -28
20 GHz to 24 GHz -21 -34
24 GHz to 26.5 GHz -22 -40

1. Response from 10 MHz to 500 MHz is normal due to the PNA-X
couplers in comparison to the Test Set bridges. The bridges
have more gain in the coupled RF path.
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U3042AE16 Front and Rear Panel Features

Front and Rear Panel Features

Figure 2 U3042AE16 Front Panel

5 to 20 Test Ports Access Ports

Active
LED

Standby Switch Test Port LED’s

Test Ports — 3.5 mm Bulkhead (male)
e Port 5-20

Access Ports - 3.5 mm (female)

CPLR ARM
SOURCE IN
CPLR THRU
RCVR OUT

Test Port’s LEDs

An illuminated LED indicates an active port in Source or Receiver mode. On the front
panel “S” indicates Source test ports and “R” indicates Receiver test ports.

Standby Switch

Note that this switch is Standby only, not a line switch. The main power cord can be used
as the system disconnecting device. It disconnects the mains circuits from the mains

supply.

Active LED

When the Test Set is connected and addressed by a PNA-X, the LED is On (illuminated).
The LED is Off (not illuminated) when the Test Set is in Standby, or not addressed by the
PNA-X.

User’s and Service Guide U3042-90012 9



U3042AE16 Front and Rear Panel Features

Figure3 U3042AE16 Rear Panel

Control Lines Voltage Adjust

Line Module Test Set Interface  Pass Through Interface Ground

Control Lines and Voltage Adjust

For further information pertaining to control lines and voltage adjustments see. Refer to
“DUT Control Lines” on page 32.

Ground

Chassis ground is provided for ESD and safety connection.

Pass Through Interface

The Pass Through Interface is used to connection to another test set.

Test Set Interface

The Test Set Interface connector is used to send address and data to the Test Set from the
PNA-X.

Line Module

The line fuse, as well as a spare, reside within the line module. Figure 4 illustrates where
the fuses are located and how to access them.

Install the instrument so that the detachable power cord is readily identifiable and is
easily reached by the operator. The detachable power cord is the instrument disconnecting
device. It disconnects the mains circuits from the mains supply before other parts of the
instrument. The front panel switch is only a standby switch and is not a LINE switch.
Alternatively, an externally installed switch or circuit breaker (which is readily
identifiable and is easily reached by the operator) may be used as a disconnecting device.
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U3042AE16 Front and Rear Panel Features

Available Fuse

e Fuse (F 5 A/250V, 2110-0709) UL listed and CSA certified.

WARNING For continued protection against fire hazard replace line fuse only
with same type and rating. The use of other fuses, circuit breakers or
materials is prohibited.

Figure4 Line Fuse

CAUTION Verify that the premise electrical voltage supply is within the range specified
on the instrument.

User’s and Service Guide U3042-90012 11



U3042AE16 System Setup with N5242A

System Setup with N5242A

WARNING The opening of covers or removal of parts is likely to expose the user
to dangerous voltages. Disconnect the instrument from all voltage
sources while it is being opened.

Preparing the N5242A Network Analyzer
1. Remove the feet from the bottom of the PNA-X.

2. Remove the 2 lower standoffs and screws (0515-1619) from the rear panel on the
PNA-X.

Figure 5 Rear Bottom Feet

Standoffs (x2)

Feet (x4)

3. Install the two rear locking feet (5023-0132) onto the PNA-X, using the included screws
(0515-1619), where the standoffs were removed.

Figure 6 Install Locking Feet on PNA-X

Locking Feet
(5023-0132)

Screws (0515-1619)
Included in package
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U3042AE16 System Setup with N5242A

4. Remove the top two standoffs and screws (0515-1619) from the rear panel on the
Test Set.

5. Install the two rear locking feet onto the Test Set. Looking at the front panel, the
N5242-20206 is the right foot and the N5242-20207 is the left foot. Two screws
(0515-2317) are included with this option.

Figure 7 Install Locking Feet on Test Set

N5242-20206
|

N5242-20207

6. Place the PNA-X on top of the Test Set and ensure that the front frame of the PNA-X is
positioned slightly forward of the locks that are attached to the Test Set. Slide the
PNA-X back so the locks engage the front frame.

Figure 8 Locking the Analyzer

Network Analyzer

Front Frame
Slide the network analyzer
back to engage the lock link in

<«——— the back of the network
analyzer’s front frame,

crew

Test Set
Front Frame
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U3042AE16 System Setup with N5242A

7. Secure the PNA-X’s lower locking feet to the Test Set upper locking feet, using the
spring—loaded screws on the locking feet. Refer to Figure 9. If the PNA-X's lower locking
feet are not aligned with the screw holes in the Test Set's upper locking feet, loosen the
screws securing the feet to the instrument slightly to align and tighten.

Figure 9 Locking Feet Screws

NOTE There are two Lock-Feet kits available. Refer to “Contacting Agilent” on
page 74 for ordering information.

e PNA-X -5023-0132 (Kit includes locking feet and screws)
e Test Set — N5242-20206 (right foot) and N5242-20207 (left foot).

e Screw — 0515-2317
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U3042AE16 System Setup with N5242A

N5242A RF Interface Cable Connections

Figure 10 on page 16 illustrates the cable configuration of the Test Set to the PNA-X. The
cables have been supplied with Option 442.

1. Remove the SOURCE OUT to CPLR THRU and RCVR IN to CPLR ARM jumpers (x8)
on the PNA-X. The RCVR R1 - R4 to SOURCE OUT reference loop jumpers (x4) remain
on the front panel.

2. Connect the RF interconnect cables from the PNA-X to the Test Set in the order listed.
As you are connecting each cable, torque to 8 in-lb. Refer to Table 5 and Figure 10 on
page 16.

CAUTION Over torque will cause damage to the Test Set and may cause connectors to

spin or become loose.

Table 5 N5242A RF Interface Cable Connection (Option 442)
Numeric | RF Cables From PNA-X To Test Set
Order

1 U3042-20122 Port 1 CPLR THRU Port 5 CPLR THRU
2 U3042-20120 Port 1 SOURCE OUT Port 5 SOURCE IN
3 U3042-20119 Port 1 CPLR ARM Port 5 CPLR ARM
4 U3042-20121 Port 1 RCVR A IN Port 5 RCVR OUT
5 U3042-20123 Port 3 CPLR ARM Port 6 CPLR ARM
6 U3042-20123 Port 3 RCVR C IN Port 6 RCVR OUT
7 U3042-20124 Port 3 SOURCE OUT Port 6 SOURCE IN
8 U3042-20124 Port 3 CPLR THRU Port 6 CPLR THRU
9 U3042-20123 Port 4 RCVR D IN Port 7 RCVR OUT
10 U3042-20123 Port 4 CPLR ARM Port 7 CPLR ARM
11 U3042-20124 Port 4 SOURCE OUT Port 7 SOURCE IN
12 U3042-20124 Port 4 CPLR THRU Port 7 CPLR THRU
13 U3042-20126 Port 2 CPLR THRU Port 8 CPLR THRU
14 U3042-20128 Port 2 SOURCE OUT Port 8 SOURCE IN
15 U3042-20125 Port 2 RCVR B IN Port 8 RCVR OUT
16 U3042-20127 Port 2 CPLR ARM Port 8 CPLR ARM

User’s and Service Guide U3042-90012
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U3042AE16 System Setup with N5242A

Figure 10 illustrates the final two digits of the part number for each cable. The cables must
be connected in the numeric order listed in Table 5 on page 15.

Figure 10 PNA-X RF Interface Cable Connections
19 21 23 23 23 23 25 27

20

22 24 2424 24 26

3. Connect the PNA-X Test Set I/0 cable (8120-6818) to the Test Set Interface connector on
the rear panel.

Figure 11 Rear Panel N5242A with U3042AE16
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U3042AE16 Controlling the U3042AE16 with N5242A

Controlling the U3042AE16 with N5242A
This section will describe how to operate the Test Set with the PNA-X.

The Test Set is considered a “slave” instrument. A PNA-X must be used to control the Test
Set. There are three methods to control the Test Set. Multiport mode is recommended due
to calibration and ease of use.

¢ PNA-X Multiport Mode
e PNA-X Interface Control
e PNA-X GPIB Command Processor

N5242A Multiport Mode for Option 551

The PNA-X multiport mode selects the Test Set file that will enable the PNA-X to control
the Test Set. The PNA-X multiport mode allows you to complete a N-Port calibration using
the Cal Wizard application in the PNA-X. Refer to the Help menu for more information.

How to Access Multiport Mode

1. The Option 551 must be installed for multiport capability. To access the multiport
application select Utility > System > Configure > Multiport Capability.

Figure 12 Selecting Multiport Mode

File Trace/Chan Response Marker/Analysis Stimulus | Utility Help
$11 LogM 10.00dB/ 0.00dB D
[d  Security...
SICL/GPIB/SCPL... Configure 4
Control Panel... Service 4
System Z0... Touchscreen »
Power Meters... T

Preset

User Key...
Keys...

External Device Config...

Millimeter Module Config...

Multiport Capability...

Preferences...
LAN Status...

-20.00

-30.00

4000 User Preset
5000 on | OFF
H  >chi: Start 10.0000 MHz — Stop 26.5000 GHz

cH1 1T 2{2 3[3 a4 5[5 &6 7/7 &8 o8 1010 1107 1202 1313 14/74 15[15 1616 1717 1818 1218 20{20

Cont.  CH1: S11 No Cor LCL
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U3042AE16 Controlling the U3042AE16 with N5242A

2. Select U3042AE16 (20-Port System) from the drop-down menu and select Restart as a
multiport PNA with this testset > OK. The PNA-X will restart the network application
with the Test Set interface features.

If the Test Set is not available in the drop-down list, it will be necessary for you to copy the
required Test Set file to the PNA-X hard drive. The current version of the Test Set files are
available on the web at http:/na.tm.agilent.com/multiport. Copy the appropriate file to
c:\program files\ Agilent\Network Analyzer \testsets directory.

Figure 13 Test Set Selection

Multiport Restart il
Testset:|U3042AE167PN. v l Address/ 1D IU

(" Restart as a standalone PMNA.

@ Restart as a multiport PNA with this testsel

port count = I 20
OK | Cancell Help |

External Test Set Control Feature

To verify that the network application has the Test Set interface features, select
Trace/Chan > Channel > Hardware Setup > External Test Set > Other. The Test Set will be
displayed as External Test Set Control-U3042AE16. Refer to Figure 14 and Figure 15.
Figure 14 External Test Set Control

File | Trace/Chan Response Marker/Analysis Stimulus Utility Help
> m

Trace

o I . On Chanrel...

Turn Off Channel...
Select Channel...

New Trace...
Trace Max
Measurement Class... Measurement Class...

Copy Channel...

Hardware Setup 4 Path Config...

Pulse Generators Setup...
IF Config...

Interface Control...
External Test Sets E5091A...

-20.00

-30.00

4000 User Preset
50,00 on | OFF
n >Ch1: Start 10.0000 MHz — Stop 26.5000 GHz

CH1-1[1 202 3[3 4[4 5[5 66 77 &8 9/a 1010 1117 12012 1313 1414 1515 1616 1717 1818 1919 2020 :

Cont  CHI1: S11 Mo Cor LCcL
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U3042AE16 Controlling the U3042AE16 with N5242A

This menu will allow the physical Ports 1 thru 20 to be identified as any port for your
convenience. For example; Port 5 can be named Port 2.

The External Test Set Control-U3042AE16 also allows control of the DUT control lines,
refer to “DUT Control Lines” on page 32. To change the state from LOW to HIGH, select
the graphical user interface (GUI) for the specific control (LINE 1 thru 8) > OK. Each line
can be controlled separately.

Select the Port Control down arrow for Ports 9 thru 16, see Figure 15.

Figure 15 External Test Set U3042AE16 (Port 1 - 20)

External Testset Control - US042AE16_PNAX il
~Select Test Set by ID —Control Lines
Select ID. [0 Linel LOW
Line 2 LOW
i Test Set
Line 3 LOW
Testset: ad .
Line 4 LOW
[+ Show Test Set Properties [ Enable Test Set Control Line 5 LOW
Test et | — MULTIPORT MODE —- =@ | Lowy
Line 7 LOW
~Port Control Line 8 LOW
Port 1 Port 2 Port 3 Port 4
A2 8 PR (N T | CREA S
Port 5 Port 6 Port 7 Port 8 LI
b =l =F =k =

Trace Measure S-Parameter

S-Parameter selection can be accomplished using Response > Measure. Use the
drop-down menu to select 1 of 400 S-Parameters for the 20-Port system, see Figure 16. The
first number in the Sxx selection is the Receiver Port and the second number will be the
Source Port. Any port can be selected to be the Receiver, Source or both, as in S11. The
front panel R LED indicates the port is the Receiver and the S LED indicates the port is
the Source.

Figure 16 Trace Measure

File TracefChan | Response MarkerfAnalysis Stimulus Utility Help
517 :
Measure Balanced » S2?
Format > S3?
Scale S47?
Display S5?
Avg S67?
Cal s7?

S8 ?
S92
S10°?
S11?
S12°?

" S13?
S14?
S15?
S16?
S17?
S18?
S19°?
S20?

3
3
3
3

Scale...
Cal Wizard...

Measure...
Measurement Class...
>Ch1: Start 10.0000 MHz — Stop 26.5000 GHz

cH1 11 2(2 3[3 4[4 5[5 6[6 77 8[8 9/ 10010 11:07 1212 1313 14[14 1515 1616 17,17 18018 1919 20,20
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U3042AE16 Controlling the U3042AE16 with N5242A

New Trace Measure S-Parameter

S-Parameter Tab: Multiple S-Parameters can be made from the New Trace menu. In the
drop-down menu select Trace/Chan > New Trace. The dialog box allows the selection of any
of the 400 S-Parameter's.

Figure 17 New Trace Measure
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Balanced Tab: Balanced Measurements can be configured by selecting the Balance tab
in the New Trace menu.

For more information on balanced (differential) component measurement, refer to the
Application Note 1373-1 and 1373-2 (5988-5634EN and 5988-5635EN) at
http://www.home.agilent.com. In the search menu type “Multiport and Balanced.”

Figure 18 Selecting Balanced Measurements

x
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Receivers Tab: The S-Parameter measurements can be ratioed with selectable
Denominators for each port and receiver. Refer to the standard PNA-X documentation for
more information.

Figure 19 Receiver Measurements
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Sweep Setup for Multiport and Standalone PNA-X Modes

When the test set is connected to the PNA-X, it is recommended that the analyzer’s Sweep
Setup be configured to Stepped Sweep before calibrating. This is slower than the Analog
Sweep, but is more accurate due to the extra electrical length of the test set and test port
cables. Only Stepped Sweep is available on all PNA models.

1. On the PNA-X select STIMULAS > Sweep > Sweep Setup.
2. Select the Stepped Sweep-sweep moves in discrete steps check box.
3. Set the Dwell Time to 5 us > OK.

Figure 20 Sweep Setup

Sweep Setup X |
I‘I :,v Channel

—P» ¥ Stepped Sweep - sweep moves in discrete steps
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0K | Cancel Help
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N-Port Calibration with N5242A

It is recommended that you perform an ECal characterization to minimize the connections
required for multiple port calibration. The N4691A/B Option MOF is recommended with
cable (85131F) if you are calibrating at the PNA-X and Test Set ports.

Characterize the ECal module with adapters that will not be used in the measurement of
the DUT.

Calibrate at the end of the test port RF cables and any adapters that are used to connect
the DUT. This removes the effect on the measurement of the DUT. Failure to do this will
create ripple and other measurement errors. Refer to the PNA-X Help menu, Ecal >
user-characterization.

NOTE If measurement errors occur, ensure the newest version of firmware is
installed on the PNA. Measurement errors can be a result of firmware
algorithms. Consult with Agilent Service or firmware web page for the latest
PNA, PNA-L or PNA-X Option 551 firmware revisions and history.
http:\ \na.tm.agilent.compna \ firmware \ firmware.htm.

Figure 21 ECal Characterization
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NOTE If the PNA-X has Option 029 (noise figure capability) verify that the path
configuration is set to default. If the PNA-X is not in Default configuration,
ports 5,9, 13, and 17 will not operate correctly. Select Trace/Chan > Hardware
Setup > Path Cong... and in the drop-down menu select Default > OK.

Save this configuration as a User Preset by selecting Save > User Preset >
Save current state as User Preset. Do not use the factory Preset (User Preset
Off), the PNA-X will return to Option 029 path configuration.

Figure 22 RF Path Configuration
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1. On the PNA-X select Response > Cal Wizard.

a. If using a mechanical cal kit, select SmartCal (Guided Calibration) > Next.

b. If using an ECal module, connect the ECal to an available PNA-X USB port and
select Use Electronic Calibration (ECal) > Next.

Figure 23 Begin Calibration

Calibration Wizard: Begin Calibration X

¢ SmartCal (GUIDED Calibration): Use Mechanical Standards

(" UNGUIDED Calibration (Response, 1-por, 2-port): Use Mechanical Standards Select calibration preference.

Mot sure sbout preferences?
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< Back I Mesxt > I Cancel Help
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2. Continue following the Cal Wizard prompts. In the Select Calibration Ports and ECal
Module dialog box select the Select All check box, or select the ports you are calibrating
and click Next.

Figure 24 20-Port Calibration

Select Calibration Ports and ECal Module b 4 |

Parts to Calibrate ECal Canfiguration
[v Parti [v Part2 v Port3 [v Portd & Select All | Selected Cal Kit I4B681-60004
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v Port13 [v Port14 [v PortlS [ Partl w
p | L'J View/Select ECal Module |

[~ Show Advanced Settings (Orientation & Thru Cal Section)

Cancel | Help |

< Back

3. Connect the ECal or the mechanical cal kit to the ports you are calibrating following the
Cal Wizard prompts and click Measure after each connection. The electrical delay value
may be shown in the dialog box after the last measurement, click OK.

4. At the Calibration Completed prompt click Save As User Calset, type the name and
Save. See Figure 35 on page 43.

5. After calibrating Test Set ports, use a quality load and short to verify the calibration on
each port or end of the test cable. Measure reflection and confirm the return loss is as
expected. If the result is not as expected, repeat the calibration without the Test Set and
ensure that the PNA-X is in standard (non-multiport) mode.

NOTE If measurement errors occur, ensure the newest version of firmware is
installed on the PNA-X. Measurement errors can be a result of firmware
algorithms. Consult with Agilent Service or firmware web page for the latest
PNA-X Option 551 firmware revisions and history.
http:\ \na.tm.agilent.compna \ firmware \ firmware.htm.
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N5242A Interface Control

NOTE The interface control will not function properly when using multiport mode.
The multiport mode will reset the switch path commands of the interface
control. It is recommended that the PNA-X be restarted in stand-alone mode
if the interface control is being used.

This section includes the interface control information for the Test Set. Applications and
connectivity information can be found in the PNA-X Help menu.

e Overview
e How to Access Interface Control Settings
¢ Interface Control dialog box

Other connectivity topics can be found in the PNA Help menu.

Overview of the Interface Control

The Interface Control feature allows you to send data and remote commands to control
external equipment using the GPIB, Material Handler I/O, Test Set I/0, and Auxiliary I/O
without needing to create a remote program. Refer to PNA-X Help menu, “Rear Panel
Tour.”

e A unique set of control data can be sent for each channel. In addition, a unique set of
control data can be sent before the channel sweep starts and after the sweep ends.

¢ Interface Control settings can be saved and recalled from the Interface Control dialog
box or with Instrument State Save and Recall.

¢ Interface Control settings can be copied to other channels using Copy Channels.
¢ Control data can only be WRITTEN to the interfaces, NOT READ from the interfaces.

¢ Control data is sent in the following order and this order cannot be changed:
Refer to the PNA-X Help menu.

1. GPIB Interface

2. Material Handler Interface
3. Test Set Interface

4. Dwell Time
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How to Access Interface Control Settings

This section describes how to configure and operate the Test Set with the PNA-X. To access

the Interface Control application select Trace/Chan > Channel > Hardware Setup >
Interface Control in the drop-down menu, and select Enable Interface Control.

NOTE

The PNA-X Series Network Analyzer comes with the Interface Control

application. Please review this application before connecting the Test Set to
the PNA-X. Information regarding this application can be found in the PNA-X
Help menu, Interface Control. The application is shown below.

Trace
Channel

New Trace...

Trace Max

File | Trace/Chan Response Marker/Analysis Stimulus Utility Help
> Y

e Start Cal
id Turn On Channel...

Turn Off Channel...
Select Channel... Cal Wizard...

-10.00

-20.00

-30.00

-40.00

Class... Class... el Interface Control

Cal
Copy Channel... Preferences... ¥ Enable Interface Control

(LGl Sy Y| i Garie Global Chanrel {1 - Channel Contral Labek:

Pulse Generators Setup... Delta Match...
IF Config... | Eefore Swesp Start } After Sweep End }

Interface Control... GFIB Commands - BEFORE

External Test Sets 4 — | ¥ Enable Contral

Mechanical Device

-Ch1: Start 10,0000 MHz — Stop 265000 GHz Port B 0-255)

[
CH11{1 2f2 3/3 4[4 5[5 66 7/7 88 a8 1010 1111 12012 1313 14[14 1515 1616 1717 1818 1219 2020 ’ Part (0-18)
(

No Cor Lol potn [ (0-15) L 140 Output Woltage
v Enable Control

Cont.  CH1: S11

Drweell After Command DACT [0V -» +10)

R e G E

Handler /0 Control Test Set 1/0 Control (addr. data)
¥ Enable Contral ¥ Enable Control

-50.00 \— Retun Port & [0-255]
[

-

=

Reset Al Save| Hecal

Cancel ‘

Help

NOTE

While using Interface Control, the PNA-X must be in GPIB System Controller

mode. Once this is complete you must restart the PNA-X application to go

back to Talker/Listener.
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Test Set I/O Address and Data using Control Interface with N5242A
An Instrument Preset will reset all of the fields to their default settings.

NOTE If an error is encountered when sending Interface Control data, an error
message is displayed on the PNA-X screen and the Channel Trigger State is
set to Hold. You must fix the condition that caused the error, then change the
Channel Trigger State to its original setting.

Enable Interface Control:

Enables and disables ALL Interface Control communication. When cleared (default
setting) Interface Control is disabled and NO data is sent. To send data, the individual
interfaces must also be enabled.

Test Set I/0 Control (address data):

Provides control of the Test Set I/O Interface on the rear panel of the PNA-X. Used to
control your Test Set.

Positive integer is used to select switch position or state of DUT control interface line.

Address and data are separated by a period. Entries should be separated by a new line, or
carriage return.The front panel Enter key inserts a new line into the field. The number of
Test Set I/0 entries that can be entered is limited by the available memory of the PNA-X.

See “Test Set I/O Interface Commands” on page 37.

For example:

0.0
16.1
32.2
Interface Control
¥ Enable Interface Control
Channel [1 =]  Channel Conlrol Label
Before Swesp Start | After Swesp End |
~ GPIB Commands - BEFORE
1% Enable Control
~Handler 120 Contral ~Test Set /0 Contral {addk. data)
[¥ Enatle Contral [¥ Enable Contral
Fort &4 0285 | 00 -
161
PortB waes)| | 5] H
PorC g |
PotD [ (015 | AUl Duputvilage
[¥ Enable Control
Duell After Command DACH (04 > +10v)
{ [ e paca [ 0 +10V)

ResetAll EI Recal e Help

Channel 1:

Specifies the channel number for dialog settings. Each channel is configured individually.
The list box illustrates the channels that currently have measurements. There must be at
least one measurement present in order to make the settings.

Channel Control Label:
Specifies the label to be displayed on the PNA-X screen during the channel sweep.
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Before Sweep Start — After Sweep End Tabs:

Commands /data for all four interfaces can be sent Before Sweep Start and After Sweep
End. However, they are configured and enabled on separate tabs of the Interface Control
dialog box. For example; to send GPIB commands Before and After a PNA-X sweep, the
Enable Control check box must be selected and commands entered on both the Before
Sweep Start and After Sweep End tabs.

Before Sweep Start:

The data is sent before the first trace on the channel begins sweeping.

After Sweep End:

The data is sent after the last trace on the channel completes sweeping.

Address:

Positive integer is used to specify switch path to be controlled. Address also specifies
output on specific ports. Refer to “Test Set I/O Interface Commands” on page 37.
Dwell After Command:

Specifies a wait time in milliseconds, after all commands to all interfaces are sent. Any
positive integer is allowed. This is used to allow all external devices to settle before
beginning a measurement. An erratic trace may indicate that more settling time is needed.

Reset All:

Sets all fields on all channels to their default values.

Handler I/0 Control and Aux I/0 Output Voltage:

Provides I/O interface control through the rear panel of the PNA-X. Refer to the PNA-X
Help menu for further information.

Save and Recall:

Saves and recalls the contents of the dialog box. If the Interface Control dialog box is
populated with settings during an Instrument State Save, the settings are automatically
recalled with the instrument state settings. Interface control uses an *.xml file type. An
example file is stored on the PNA-X hard drive. You can recall it into the dialog, or you can
open and edit it with a word processor, such as Word Pad.

OK:
Applies the settings and closes the dialog box.

Cancel:

Does not apply changes that were made and closes the dialog box.

NOTE Test Set I/O Commands can be found in “Test Set I/O Interface Commands”
on page 37. The Address and Data commands can be entered into the Test Set
I/O control.
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N5242A GPIB Control

The GPIB Command Processor feature allows you to send remote commands and data to
the PNA-X rear-panel GPIB connector and Test Set I/O connector. More information
regarding the GPIB Command Processor can be found in the PNA-X Help menu.

e Overview
e How to Access GPIB Command Processor

e GPIB Command Processor Console

Overview of the GPIB Control

The GPIB Command Processor allows you to send address and data to control an external
Test Set, without needing to create a remote program. The user is required to manually
input address and data using the GPIB Command Processor Console in the PNA-X Help
menu.

¢ GPIB Command Processor settings can not be saved or recalled.

e Address and data can be written from the GPIB Command Processor.
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How to Access GPIB Command Processor

Controlling the U3042AE16 with N5242A

1. To access the GPIB Command Processor select Utility > System > Configure >

SICL/GPIB/SCPI.

Figure 25 Utility Configure
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2. Select GPIB Command Processor Console > OK.

Figure 26 GPIB Command Processor
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GPIB Command Processor Console

Write Commands Once the GPIB Command Processor Console is open, commands can
remotely control the external Test Set I/O connector by sending the following:

address: a integer number

data: a integer number

Address and data are separated by a comma. Commands should be separated by a new
line, or carriage return.

For example:

CONT:EXT:TEST:DATA <address>,<data>
CONT:EXT:TEST:DATA 0,0

Example: CONT:EXT:-TEST:DATA 0,0

“{ GPIBE Command Processor

For current command list. type :8Y¥S8Tem:HELP:HEADers?
To gquit,. type GControl-Z,. then Enter.
Type * followed by a filename to execute commands from a text file.

GPIB> CONT:EXT:TEST:DaTh 9.8
time=Bms

Refer to “Test Set I/O Interface Commands” on page 37.
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DUT Control Lines

The 15 pin female D-Sub connector on the rear panel provides 8 latched data connections
that can be used to control your DUT. An adjustable voltage source (+2 to +5 Vdc) is
provided on the rear panel. A positive or negative external source can be used. Refer to
Table 8 and Figure 30 on page 36.

Setting the DUT Control Interface

This section describes how to control the DUT control lines. Refer to “Controlling the
U3042AE16 with N5242A” on page 17. For more information regarding the control lines,
see Table 6 and Table 7.

Table 6 Test Set DUT Control Address and Data

Address | Data | Data Description Bit Data
AD12-ADO 0= +Voltage
1= -Voltage
112 0 0000000000000 | ALL DUT Control Lines set to 0 or + voltage
112 255 0000001111111 | ALL DUT Control Lines set to 0 or — voltage
112 1 00000xxxxxxxB | DUT Control Line 1 0,1
112 2 00000xxxxxxBx | DUT Control Line 2 0,1
112 4 00000xxxxxBxx | DUT Control Line 3 0,1
112 8 00000xxxxBxxx | DUT Control Line 4 0,1
112 16 00000xxxBxxxx | DUT Control Line 5 0,1
112 32 00000xxBxxxxx | DUT Control Line 6 0,1
112 64 00000xBxxxxxx | DUT Control Line 7 0,1
112 128 00000Bxxxxxxx | DUT Control Line 8 0,1
Control Lines Line 8 | Line 7 | Line 6 | Line 5 | Line4 | Line 3 | Line 2 | Line 1
Test Set I/O Bits AD7 ADG6 AD5 AD4 AD3 AD2 AD1 ADO
Bit Decimal Equivalent 128 64 32 16 8 4 2 1
Example 1 Data =0 0 0 0 0 0 0 0 0
Example 2 Data = 21 0 0 0 1 0 1 0 1

X indicates unknown user bit state

B indicates bit of interest

To select a Test Set DUT control line configuration, all 8 DUT control lines must be set. To do this you
must add AD7 to ADO binary number and convert this to a decimal equivalent.
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NOTE All DUT control lines must be set with each command sent. Logic 0 = high

Figure 27 DUT Control Line Pin Assignment
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Table 7 DUT Control Line Pin Assignment

Pin Signal Name | Description
Number
1 Line 1 Output port of line 1
2 Line 2 Output port of line 2
3 Line 3 Output port of line 3
4 Line 4 Output port of line 4
5 Line 5 Output port of line 5
6 Line 6 Output port of line 6
7 Line 7 Output port of line 7
8 Line 8 Output port of line 8
9 Not used
10 Not used
11 Not used
12 +2V to+5V | The voltage input to pin 13. (The voltage can be varied by
rotating the voltage adjustment trimmer on the rear panel).
13 Positive Input | Input a signal that is outputted when each line is high from
pin 12 or external dc power supply.
14 Negative Input | Input a signal that is outputted when each line is low from
the external dc power supply. Able to output 0 V as low from
the each line by connecting to pin 15.
15 Gnd ground terminal
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Setting the Variable Source Voltage

The output voltage of pin 12 can be varied from +2 to +5 V. Perform the following procedure
to set the voltage:

1. Turn On the Test Set.
2. Measure the voltage between pin 12 and 15 using a multimeter.

3. Rotate the voltage adjustment trimmer on the rear panel until the multimeter indicates
the appropriate voltage.

Connecting to the DUT Control Lines

Figure 28 illustrates an example of the connection between the DUT and the Test Set
without an external dc power supply. Connect pin 12 to pin 13 for +5 V, and pin 14 to pin 15
to provide the ground path. Connect each DUT control line to the external device under
test.

CAUTION You may only connect pin 12-13, and pin 14-15. Damage may result if any
other path is short—circuited.

Figure 28 Control Line Connector

To BUT {required line anly)
i
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Using an External Power Supply

Figure 29 illustrates an example of the connection between the DUT and the Test Set with
an external dc power supply. Input the High and Low signals from the external power
supply to the Positive Input and Negative Input respectively, and connect each line to the
control terminal of the DUT.

Turning On the Test Set using an External Power Supply.

1. Turn On the Test Set.

2. Connect the DUT.

3. Turn On the external power supply.

Turning Off the Test Set using an External Power Supply.
1. Turn Off the Power Supply.

2. Turn Off the Test Set.

3. Disconnect the DUT.

Figure 29 Test Set to the DUT and External DC Power Supply

DS power supphy

To DUT (fequired line only)

SV~ OV
I~ 5
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Table 8 DUT Control Specifications

Item Specifications
Connector Shape 15—pin female D—-Sub
Voltage Range:

Positive Input 0to+5V

Negative Input -5to0V
Maximum Current 100 mA (in total of each line)
Impedance <10Q
Range of Variable Voltage | +2to +5V

Figure 30 Block Diagram of DUT Control

< Positive : 0~+5V

< Megative ; -5~0%
- ——> Line 1
k“O—D ——> Line 2
Q“‘O—D ——> Line 8
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Test Set I/0 Interface Commands

Switch Address and Data

Refer to Table 31 on page 37 and Figure 33 on page 39 for information to set the internal
switch paths of the Test Set. Additional information regarding the operation and
descriptions for the internal switches can be found in “Theory of Operation” on page 52.

A combination of the address and data value controls the source and receiver paths of the
ports. To select a Test Set port configuration, both Source and Receiver switches must be
set to complete the switch paths. Refer to the following examples.

Example 1: Refer to Figure 32 on page 38.

If the ports have the same address, only one command is needed.

Ports 9 is the Receiver and Port 5 is the Source.

Source Port 5 = address 0, data 1, and Receiver Port 9 = address 0, data 32. Since the
addresses are the same, add the data value of 1 + 32 = 33. Send address 0 and data 33.
Refer to Figure 32 on page 38.

Example 2:

If the ports have different addresses, two separate address data commands must be used.
Port 5 is the Source and Port 6 is the Receiver.

Source Port 5 = address 0, data 1 and Receiver Port 6 = address 16, data 16.
Two separate commands must to be sent, you may use the same dialog box. Send address 0
and data 1 in one command line, and address 16 and data 16 in the second line.

For further information refer to “How to Access Interface Control Settings” on page 26 and
“How to Access GPIB Command Processor” on page 30.

Figure 31 N5242A Port Address and Data Select!

Address Source Path Receiver Path
Data 0 1 2 3 4 0 16 32 48 64
0 Ports 1 5 9 13 17 1 5 9 11 13
16 Ports 3 6 10 14 18 3 6 10 14 18
32 Ports 4 7 11 15 19 4 7 11 15 19
64 Ports 2 8 12 16 20 2 8 12 16 20

1. Data 7 will terminate all Source Paths.
Data 112 will terminate all Receiver Paths.
Data 119 will terminate all Source and Receiver Paths.
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Figure 32 Example Port Selection with Test Set I/0 Control

U3042AE16 Module Address Switch

Module x

1 40
SWB ° % 9 % qu ?% §/i %
Data| Slows Data 4§ 38 2§ 13}
o4, |37 SFEARAS
o g p % o %o
X 48 |
o
i
<+WwWo
2 32':"\_ P 73
=
: 2 =5
X , 16 [ 3 IO
E)U o = 5 m
=1 ! o =
~ B} |
2 - sSwc
@ p é C i
g ’l
Y Datafl 64
© [e] —up Ly -
=3 o] S 2
o -~
Example 1 jg:y 33
Address . Data  Port _ 7 2 Z
0.33 5 Source SWQ:EW? 32 f‘y -
i = ]
9 Receiver SWC = SW10 ol
SWD = SW2 1
—I:I)—\-
0 y
W' Enable Interface Control |—|:I
Channel |1 = Charinel Control Label: i
L Tl T
Before Sweep Start NAF[ErSWEEp Emj] CPLR ARM
GPIE C ds - BEFORE
e [V Enable Contral Front Panel
[ |
[ -
Handler /0 Contral Test Set /0 Control [addr. data]
¥ Enable Control [V Enable Control
Part & [0-2585) 0.33
Fort B [0-255] il
Port C (0-15)
Potp [ [075] | [-AukI/D Dutput Vakape
e [V Enable Control
Dwell After Command DACT 108 > +10v]
[ O paca [ B0V > A04)

Rresst Al M Frecal

| Cancel

Help

¥ 0} | sJod
NYHL J71d0

38

User’s and Service Guide U3042-90012



U3042AE16 Test Set 1/O Interface Commands

Figure 33 Source and Receiver Switch Path
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Operational Check

This operational check is to confirm the Test Set and PNA-X operational performance. The
operation verification limits provided ensure that your U3042AE16 and PNA-X are
operating properly. Refer to “Troubleshooting Operational Check Failures” on page 48 to
ensure the RF interface cables are installed and working correctly before returning the
Test Set for repairs.

Verification Limits

Specifications for the Test Set are typical. System performance for the PNA-X and Test Set
are only characteristic and intended as non-warranted information. Only a functional
certificate is provided for the Test Set.

It is recommended that you return your instrument to Agilent Technologies for servicing or
repair if the Test Set and PNA-X performance exceed the operational verification limits.

A periodic calibration is not required. The Operators Check should be performed after
System Setup, or if performance is in question. An N-Port calibration should be performed
before making a measurement.

Table 9 N5242A Operation Verification Limit for Reflection Tracking1

Frequency Port 1-4 Port 5-20
10 MHz to 4 GHz -10dB -20 dB
4 GHz to 10 GHz -15dB -25 dB
10 GHz to 20 GHz -22 dB -35dB
20 GHz to 26.5 GHz -30 dB -45 dB

1. Reflection Tracking takes into account Source Loss, Receiver
Loss, Margin, and PNA-X Mixer Cal.

NOTE If you suspect that your 20-Port configuration is not operating properly,
ensure that all front RF jumper interconnect cables are correctly attached.
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Equipment Required

The Agilent U3042AE16 requires that the user be familiar with the equipment and
components listed in Table 10.

This section provides an equipment list and configuration of the PNA-X and Test Set.

Table 10 Equipment List

Description Qty

N4691A 3.5 mm ECal Module 10 MHz - 26.5 GHz (Option 00F or MOF) or 1
N4691B 3.5 mm ECal Module 300 kHz - 26.5 GHz (Option 00F or MOF) or
Mechanical cal kit 85052B or 85052D

N5242A Option 400 and 551 1

Set of interconnect cables (PNA-X and Test Set), see “N5242A RF Interface 1
Cable Connections” on page 15.
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Operational Check Procedure

The sequence of this procedure is very important and must be followed or the performance
accuracy and results may vary from the reference plots provided. Ensure that the Test Set
is not connected to the PNA-X if you are performing a PNA-X Operator’s Check. The
PNA-X will indicate false failures if the Test Set is connected.

Preparing the N5242A

1. Connect the Test Set to the 4-Port PNA-X using the interconnect cables as shown in
Figure 10 on page 16 and Table 5 on page 15.

2. Turn On the Test Set.

3. On the PNA-X, select Response > Cal > Manage Cals > Cal Set. Delete or Rename any
Cal Sets titled “999.1” thru “999.20” (20-Port), although it is unlikely that you will find
Cal Sets with these names.

4. Verify that the PNA-X is in 20-Port. See the bottom of the measurement window.

a. If only four S-Parameters are listed, select Utility > System > Configure > Multiport
Capability. Select Restart as multiport PNA with this testset and select U3042AE16
(20-Port) from the drop-down menu > OK. Refer to Figure 13.

5. Press Preset.

6. Verify that the [Start Frequency] is set to [10 MHz].

7. Verify that the [Stop Frequency] is set to [26.5 GHz].
8. Verify that the [Power] is to set to [-5 dBm)].

9. Select Response > Avg > IF Bandwidth > 100 Hz > OK.
10.Select Stimulus > Sweep > Number of Points > 401.

11.Connect the ECal module to an available PNA-X USB port on the front or rear panel.
Refer to Figure 10 on page 16. This procedure assumes you are using a ECal. If you are
not, see “N5242A 1-Port Calibration and Verification Procedure” on page 43, step 2.

12.Allow the ECal module, Test Set and PNA-X to warm up for a minimum of 30 minutes.
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N5242A 1-Port Calibration and Verification Procedure

1. Connect the ECal or the mechanical cal kit to Port 1 or the port you are testing. Refer to
Figure 1 on page 2. Torque to 8 in-lb. For further information refer to the Help menu,
see Figure 34.

2. Perform a 1-Port Calibration on Port 1. On the PNA-X, select Response > Cal > Start
Cal > Calibration Wizard...

a. If using a mechanical cal kit, select SmartCal > Next.

b. If using an ECal module, connect the ECal to a PNA-X USB port. Select Use
Electronic Calibration (ECal) > Next.

3. Continue following the Cal Wizard prompts. In the Select Calibration Ports and ECal
Module dialog box click Clear All and select Port 1 > Next > Measure.

Figure 34 1-Port Calibration

Select Calibration Ports and ECal Module il
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[v Pat1 [~ Pot2 [ Pot3 [ Portd a Select Al Selected CalKit:  N4891-60004
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( Ll—l View/Select ECal Module |

[ Show Advanced Settings (Orientation & Thru Cal Sectior)

< Back I MNewxt » I Cance! | Help |

4. Continue to follow the prompts until the Calibration Completed dialog box appears.

5. At the Calibration Completed prompt, select Save As User Calset and type the name
999.1. Overwrite the Calset if it already exists and Save.

NOTE If you do not have a key board, select Save As User Calset > Edit Name and
save as 999.x. X is the port number you are calibrating. Refer to Figure 35.
Use the numeric keypad on the PNA-X front panel to enter “999.1.”

Figure 35 Calibration Complete
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an an.
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<Back | TERE Carcel | Help |
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Edit Mame ‘ |
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6. Repeat step 1 thru step 5 for Ports 2 thru 20. When finished, there should be 20 Cal

Sets saved with the titles “999.1” thru “999.20” (20-Port).

If you are using an ECal module you can verify the individual port calibration by
selecting Response > Cal > More > ECal > ECal Confidence Check. Click Change

Measurement and select the test port S-Parameter > Apply > OK > Read Module Data.
For further information refer to the Help menu.

Figure 36 ECal Confidence Check
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Select Trace/Chan > Trace > Delete Trace. There should be no traces on the PNA-X
display.

To launch the Cal Set Viewer toolbar, select Response > Cal > Manage Cals >
Cal Set Viewer.

Figure 37 Calibration, Cal Set Viewer
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9. From the Cal Sets drop-down menu, select 999.1 and select Enable. Select the
Reflection Tracking(x,x), where x,x is the port being tested, term in the center
drop-down menu and ensure that the Enable and Error Terms are selected.

NOTE You may also create a table on the PNA-X and enter the limit line stimulus
and response values. Select Marker/Analysis > Analysis> Limit Test > Limit
Test ON and Limit Line ON > Global pass/fail display ON > Show Table. See
Figure 38 and Figure 39.

Figure 38 PNA-X Setting the Test Limits
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Figure 39 Reflection Tracking Trace with Limit Line Table
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10.Compare the Reflection Tracking (1,1) trace to the appropriate limits in Table 9 on
page 40. This can be done using Limit Lines, select Marker/Analysis > Analysis > Limit
Test > Limit Test ON and Limit Line ON > Global pass/fail display ON, and click Show
Table. The trace should be above the limit. PASS will be displayed on the screen if the
limit lines are used.

11.Repeat step 9 and step 10 for Cal Sets “999.1” thru “999.20” (20-Port).

NOTE Response from 10 MHz to 500 MHz is normal due to the PNA-X couplers in
comparison to the Test Set bridges. The bridges have more gain in the coupled
RF path.

Figure 40 Standard Reflection Tracking Trace (Port 1-4) with PNA-X
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Figure 41 Standard Reflection Tracking Trace (Port 5-20) with PNA-X
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NOTE Response from 10 MHz to 500 MHz is normal due to the PNA-X couplers in
comparison to the Test Set bridges. The bridges have more gain in the coupled
RF path.
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Troubleshooting Operational Check Failures
If your test results fail the Operational Check limits, verify following:

1. Insure that the Test Set is turned on and connected properly to the PNA-X.

2. Check all appropriate PNA-X and Test Set connectors for damage, cleanliness, and
proper torque.

3. Repeat the relevant 1-Port calibrations.

4. Verify that the PNA-X is operating properly and meeting its published specifications. If
the PNA-X is connected to the Test Set it will fail the Operational Check.

Interconnect Cable Verification

1. Connect the Test Set to the PNA-X and select Multiport mode.
2. Verify the Source Interconnect RF cables (Source Out and CPLR THRU).

a. Remove the Receiver and CPLR ARM interconnect cables and install the standard
PNA-X jumpers.

b. Connect two RF cables on the PNA-X, Port-1 to Port-2 and Port-3 to Port-4.

c. Set the PNA-X to measure Trace S12, S21, S34 and S43, and verify that there are no
power holes. If S12, or S34 has a power hole check the Port-2, or Port-4 Source
interconnect cables and Test Set connectors for damage. If S21, or S43 has a power

hole check the Port-1, or Port-3 Source interconnect cables and Test Set connectors
for damage.

3. Verify the Receiver Interconnect RF cables (Receiver A IN or B IN and CPLR ARM).

a. Re-install the Receiver and CPLR ARM interconnect cables.

b. Remove the Source Out and CPLR THRU interconnect cables and install the
standard PNA-X jumpers.

c. Set the PNA-X to measure Trace S12, S21, S34 and S43. Verify that there are no
power holes. If S12 or S34 has a power hole check Port-1, or Port-3 Receiver
Interconnect cables and Test Set connectors for damage. If S21, or S43 has a power
hole check Port-2, or Port-4 Receiver Interconnect cables and Test Set connectors for
damage.

4. If the problem still exists, connect the standard jumpers to the PNA-X (Source and
Receiver) and verify the Source Out to CPLR THRU and A/B IN to CPLR ARM switch
paths.

a. Connect two RF cable, one to Port-1 and one to Port-2.
b. Set the PNA-X to measure trace S12 (all standard jumpers connected).

c. Connect the Port-1 cable to Source Out and Port-2 cable to CPLR THRU connectors
on the Test Set. If a power hole still exists refer to “Contacting Agilent” on page 74.

d. Connect Port-1 to Receiver A IN or B IN and Port-2 to CPLR ARM connectors on the
Test Set. If a power hole still exists refer to “Contacting Agilent” on page 74.
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Service Information

Refer to “Contacting Agilent” on page 74.

WARNING No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock do not remove covers.

WARNING These servicing instructions are for use by qualified personnel only.
To avoid electrical shock, do not perform any servicing unless you

are qualified to do so.

Replaceable Parts

Special options are built to order, long lead times may be encountered when ordering

replacement parts.

Description

Agilent

Part Number

RF Cable, Semi-rigid

U3042-20120

RF Cable, Semi-rigid

U3042-20122

RF Cable, Semi-rigid

U3042-20119

RF Cable, Semi-rigid

U3042-20121

RF Cable, Semi-rigid

U3042-20124

RF Cable, Semi-rigid

U3042-20123

RF Cable, Semi-rigid

U3042-20123

RF Cable, Semi-rigid

U3042-20124

RF Cable, Semi-rigid

U3042-20123

RF Cable, Semi-rigid

U3042-20123

RF Cable, Semi-rigid

U3042-20124

RF Cable, Semi-rigid

U3042-20124

RF Cable, Semi-rigid

U3042-20127

RF Cable, Semi-rigid

U3042-20126

RF Cable, Semi-rigid

U3042-20128

RF Cable, Semi-rigid

U3042-20125

RF Cable, Semi-rigid

U3042-20076

SW Interface Board, programmed

U3042-63130

Dress Nut (coupler/bridge)

N5230-20081

PNA-X Test Set Rear Lock Feet (right)

N5242-20206
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Description

Agilent
Part Number

PNA-X Test Set Rear Lock Feet (left)

N5242-20207

10 LED Board (programmed)

N5261-60005

Test Set Control Board (programmed)

N5261-60006

Quad Switch, 26.5 GHz

5087-7306

Fan (rear panel)

87050-60027

DUT Control Board

E5091-66503

PNA-X Locking Feet 5023-0132
Rackmount kit without Handles 5063-9216
Rackmount kit with Handles 5063-9236
Front Handles 5063-9229
Coupler Bridge 5087-7716
Screw 0515-2317
PWR Supply (AC/DC SWG 650W 9- Output 0950-4729
Fuse (8 A 250 V non-time delay 0.0146 Ohm 2110-0342
Fuse (5 A 250 V non-time delay Socket 2110-0709
Test set 10 Cable 8120-6818

U3042A Option E16 User’s and Service Guide
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U3042AE16

U3042AE16 with PNA-X Block Diagram

Figure 42
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Theory of Operation

The following is a description of the operation of the Test Set. Reference the Test Set block
diagrams shown in Figure 42 on page 51. This section assumes the user has a general
understanding of couplers, switches, and network analyzers.

There are four modules, a module is a group of four switches and couplers controlling the
source and receiver paths of the PNA-X and Test Set. Refer to Figure 33, “Source and
Receiver Switch Path.”

RF Coupler/Bridges

The Test Set uses sixteen coupler/bridges (5087-7716) on the front panel for RF Test
Ports 5 - 20. The coupler/bridges provide the signal separation of the source and receiver

paths, using resistor networks. The Test Set ports can receive from or stimulate a signal to
the DUT.

The RF Test Ports are 3.5 mm male connectors. The coupling factor is approximately

—-16 dB for the Coupled Arm (minimum —-22 dB and max —-12 dB at 26.5 GHz). The
insertion loss through the CPLR THRU path is typically < 4 dB at 26.5 GHz for the
coupler. Do not use excessive RF power or DC voltage, or damage may occur to the internal
resistors.

RF Switch Components

The Test Set uses sixteen solid-state switches that have internal 50 Ohm terminations for
each path. The switches select the RF paths from the PNA-X source and receiver through
interconnect cables to the Test Set. PNA-X Ports 1 to 4 and Test Set Port paths 5 to 20.

Source and Receiver Switch Paths

SW1 and SW9 Source to Ports (1,5, 9, 13 and 17)

Switch 9 provides control of the Source Output path to PNA-X Port 1 and with SW1 for
Test Set Ports 5, 9, 13 and 17. In the state shown in the block diagram, switches 1 and 9
route the RF Source back to the PNA-X Port 1, and the Test Set Source path to Ports 5, 9,
13 and 17 are terminated.

SW3 and SW11 Source to Ports (3, 6, 10, 14 and 18)

Switch 11 provides control of the Source Output path to PNA-X Port 3 and with SW3 for
Test Set Ports 6, 10, 14 and 18. In the state shown in the block diagram, switches 3 and 11
route the RF Source back to the PNA-X Port 3, and the Test Set Source path to Ports 6, 14
and 18 are terminated.
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SW5 and SW13 - Source to Ports (4, 7,11, 15 and 19)

Switch 13 provides control of the Source Output path to PNA-X Port 4 and with SW5 for
Test Set Ports 7, 11, 15 and 19. In the state shown in the block diagram, switches 5 and 13
route the RF Source back to the PNA-X Port 4, and the Test Set Source path to Ports 7, 11,
15 and 19 are terminated.

SW7 and SW15 - Source to Ports (2, 8, 12, 16 and 20)

Switch 15 provides control of the Source Output path to PNA-X Port 2 and with SW7 for
Test Set Ports 8, 12, 16 and 20. In the state shown in the block diagram, switches 7 and 15
route the RF Source back to the PNA-X Port 2, and the Test Set Source path to Ports 8, 12,
16 and 20 are terminated.

SW2 and SW10 - Receiver to Ports (1, 5,9, 13 and 17)

Switch 10 provides control of the Receiver Input path to PNA-X Port 1 and with SW2 for
Test Set Port 5, 9, 13 and 17. In the state shown in the block diagram, switches 2 and 10
route the Port 1 Coupler Arm to the Receiver, and Test Set Ports 5, 9, 13 and 17 Coupler
Arm path is terminated.

SW4 and SW12 - Receiver to Ports (3, 6, 10, 14 and 18)

Switch 12 provides control of the Receiver Input path to PNA-X Port 3 and with SW4 for
Test Set Ports 6, 10, 14 and 18. In the state shown in the block diagram, switches 4 and 12
route the Port 3 Coupler Arm to the Receiver, and Test Set Ports 6, 10, 14 and 18 Coupler
Arm path is terminated.

SW6 and SW14 - Receiver to Ports (4, 7, 11, 15 and 19)

Switch 14 provides control of the Receiver Input path to PNA-X Port 4 and with SW6 for
Test Set Ports 7, 11, 15 and 19. In the state shown in the block diagram, switches 6 and 14
route the Port 4 Coupler Arm to the Receiver, and Test Set Ports 7, 11, 15 and 19 Coupler
Arm path is terminated.

SW 8 and SW16 - Receiver to Ports (2, 8, 12, 16 and 20)

Switch 16 provides control of the Receiver Input path to PNA-X Port 2 and with SW8 for
Test Set Port 8, 12, 16 and 20. In the state shown in the block diagram, switches 8 and 16
route the Port 2 Coupler Arm to the Receiver, and Test Set Ports 8, 12, 16 and 20 Coupler
Arm path is terminated.
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Troubleshooting the Test Set

If the U3042AE16 is not operating properly, use the following procedures to isolate and
repair the type of failure encountered. It is recommended that a qualified service
technician perform the following procedures.

Refer to the Agilent PNA Series: Service & Support Home Page at:
http:/ Ina.tm.agilent.com/pna for further information.

To request service, please contact your local service center. In the US, call 1-800-829-4444.
For a listing of service centers worldwide, please visit us at www.agilent.com/find/service.

When sending the Test Set in for repair, also send your PNA-X and cables. This will allow
us to verify proper operation of the complete system, and speed your repair turn-around
time. Refer to “Shipping Your Product to Agilent for Service or Repair” on page 74.

Refer to the following procedures for troubling shooting. It is recommended that a qualified
service technician perform the following procedures.

WARNING No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock do not remove covers.

Fan is not Operating

Suspect a power supply problem or failed fan, and perform the following troubleshooting.

WARNING The opening of covers or removal of parts is likely to expose the user
to dangerous voltages. Disconnect the instrument from all voltage
sources before being opened.

1. Verify the front panel power switch (3101-4058) is operational.

2. Verify that the AC line voltage is correct (100 to 240 V @ 50/60 Hz) and that the power
cord is not damaged.

a. If the power cord is damaged, replace it.
b. If the AC line voltage is incorrect, use another receptacle.

3. Verify that the fuse (2110-0709) in line module is not blown. There is a spare fuse in the
line module. Refer to Figure 4 on page 11. If the fuse is working, continue to step 4.

4. Remove the top cover. Verify that the supply LED indicators on the Test Set control
board (N5261-60006) are illuminated. If the LED’s are illuminated, replace the fan
(87050-60027). Refer to Figure 44 on page 66.

5. If the LED’s are off, verify the voltages (+24, +5, +3, -15, -12, +15, +12, +9 and +10
Volts) on the Test Set Controller board. If the voltages are not correct, verify that J10 -
J14 cables are connected correctly on both the power supply and controller board. Refer
to Figure 44 on page 66.
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6. Ifthe J10 - J14 cables are connected properly, measure the voltages on the power supply
screw terminals. See the power supply voltages in Figure 43 on page 55.

Figure 43 Power Supply

7. If power supply voltages are not present, verify and/or replace the two 8 amp fuses
(2110-0342) in the line fuse assembly. Refer to Figure 44 on page 66.

a. If the fuses are correct, replace power supply (0950-4729).
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Front Panel LEDs (R, S or Active) are not Illuminated

If the U3042AE16 fan and power supplies are operating the following procedures can be
used to verify the failure. Suspect the Test Set Controller Board (N5261-60006) or Front
Panel LED Assembly (N5261-60005).

1. Verify the Test Set 1/0 cable (8120-6818) is installed correctly. See Figure 11 on page 16.

2. Using multiport mode (Option 551), verify the PNA-X firmware is correct, and the test
set file is loaded into the PNA-X, refer to “Network Analyzer Requirements” on page 3.

3. Using the I/O command values, confirm the correct address and data values are used.
Refer to “Test Set I/O Interface Commands” on page 37.

4. Remove the top cover. Verify that the supply LED indicators, on the test set control
board (N5261-60006), are illuminated.

5. If the LED’s are off, verify the voltages (+24, +5, +3, -15, —12, +15, +12, +9 and +10
Volts) on the Test Set Controller board. If the voltages are not correct, verify that J10 -
J14 cables are connected correctly on both the power supply and controller board. Refer
to “Fan is not Operating” on page 54.

6. Verify at least one of the status LEDs is on. If not, replace the controller board
(N5261-60006).

7. If the controller board status LEDs are on, and the Active LED is on, suspect the front
panel LED boards (N5261-60005) or the ribbon cables (N5261-60001). If only one set of
front panel LEDs are not working, connect the ribbon cable from one of the working
front panel LED boards to the front panel LED board assembly that is not working.
Replace if necessary.

Test Ports are not Switching

If the test ports are not switching, the following procedures can be used to verify the
failure. The procedures assume power supplies, controller board and front panel LEDs are
working. Suspect the switch interface board (U3042-63130), ribbon cable connection or
switch (5087-7306).

1. Inspect the ribbon cable connections from the test port switches to the Switch Interface
board (U3042-63130). Refer to Table 12 on page 65

2. Send a Test Set I/0O command to verify the path for each port. See “Source and Receiver
Path Test” on page 57.

3. Substitute a known good switch, or connect a known good ribbon cable to a suspect
switch and retest. Replace if necessary.

56 User’s and Service Guide U3042-90012



U3042AE16 Source and Receiver Path Test

Source and Receiver Path Test

This section provides information for testing the RF paths.

Equipment Required

e N5242A PNA-X

¢ Two Flex Cable with SMA connectors (5062-6696 or equivalent)
¢ Three SMA Adapters (female to female)

e Test Set I/O Cable (8120-6818)

Equipment Setup

1. Connect the Test Set I/0 cable (8120-6818) from the PNA-X to Test Set. Refer to Figure
11 on page 16. Set the PNA-X to “Standalone mode” (test can not be performed in
Multiport mode).

2. Connect the flexible cables (5062-6696 or equivalent) with the SMA adapters to PNA-X
Ports 1 and 2. Connect the cables together using a SMA adapter.

3. Set the frequency range to 10 MHz to 26.5 GHz, or the frequency range of the PNA-X
you are using.

4. Select measure S21 trace, and perform a Response Cal.

5. Select Ref Level 0 dB > Scale 10 dB (or Autoscale).
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Source Path Trace

The S21 trace should slope down approximately —0.5 to —10 dB for all CPLR THRU (SMA)
to SOURCE IN paths. Refer to the individual port path to be tested. The S21 trace should
slope down approximately —3 to —20 dB for test Ports 5 thru 20 to SOURCE IN (SMA)
paths.

When measuring CPLR THRU or SOURCE IN SMA connectors, the connections are to the
four SMA connectors to the right of the associated test ports being measured. See Figure 2
on page 9 for the connector locations. Start with sending command 0.0.

Port 1 Source

e Set Test I/0 addr.data 0.0

e Connect PNA Port 1 flex cable to Test Set Port 5 CPLR THRU.
¢ Connect PNA Port 2 flex cable to Test Set Port 5 SOURCE IN.
Port 3 Source

e Set Test I/O addr.data 16.0

¢ Connect PNA Port 1 flex cable to Test Set Port 6 CPLR THRU.
e Connect PNA Port 2 flex cable to Test Set Port 6 SOURCE IN.
Port 4 Source

¢ Set Test I/O addr.data 32.0

e Connect PNA Port 1 flex cable to Test Set Port 7 CPLR THRU.
¢ Connect PNA Port 2 flex cable to Test Set Port 7 SOURCE IN.
Port 2 Source

e Set Test I/O addr.data 64.0

¢ Connect PNA Port 1 flex cable to Test Set Port 8 CPLR THRU.
e Connect PNA Port 2 flex cable to Test Set Port 8 SOURCE IN.
Port 5 Source

e Set Test I/O addr.data 0.1

e Connect PNA Port 1 flex cable to Test Set Port 5.

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.
Port 6 Source

e Set Test I/O addr.data 16.1

¢ Connect PNA Port 1 flex cable to Test Set Port 6.

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.
Port 7 Source

e Set Test I/O addr.data 32.1
e Connect PNA Port 1 flex cable to Test Set Port 7.
e Connect PNA Port 2 flex cable to Test Set SOURCE IN.
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Port 8 Source

e Set Test I/O addr.data 64.1
e Connect PNA Port 1 flex cable to Test Set Port 8

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 9 Source

e Set Test I/0 addr.data 0.2
e Connect PNA Port 1 flex cable to Test Set Port 9.

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 10 Source

e Set Test I/O addr.data 16.2
e Connect PNA Port 1 flex cable to Test Set Port 10.

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 11 Source

e Set Test I/O addr.data 32.2
e Connect PNA Port 1 flex cable to Test Set Port 11

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 12 Source

e Set Test I/0O addr.data 64.2
e Connect PNA Port 1 flex cable to Test Set Port 12

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 13 Source

e Set Test I/O addr.data 0.3
e Connect PNA Port 1 flex cable to Test Set Port 13

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 14 Source

e Set Test I/0 addr.data 16.3
e Connect PNA Port 1 flex cable to Test Set Port 14

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 15 Source

e Set Test I/O addr.data 32.3
e Connect PNA Port 1 flex cable to Test Set Port 15

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 16 Source

e Set Test I/0 addr.data 64.3
e Connect PNA Port 1 flex cable to Test Set Port 16

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Source and Receiver Path Test

User’s and Service Guide U3042-90012

59



U3042AE16

Port 17 Source

e Set Test I/0O addr.data 0.4
e Connect PNA Port 1 flex cable to Test Set Port 17

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 18 Source

e Set Test I/0 addr.data 16.4
e Connect PNA Port 1 flex cable to Test Set Port 18

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 19 Source

e Set Test I/O addr.data 32.4
e Connect PNA Port 1 flex cable to Test Set Port 19

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 20 Source

e Set Test I/0 addr.data 64.4
e Connect PNA Port 1 flex cable to Test Set Port 20

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Source and Receiver Path Test
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Receiver Path Trace

The S21 trace should slope down approximately —0.5 to —10 dB for all RCVR OUT (SMA)
to CPLR ARM paths. Refer to the individual port path to be tested. The S21 trace should
slope down approximately —18 to —35 dB for test Ports 5 thru 20 to RCVR OUT (SMA)
paths.

When measuring CPLR ARM or RCVR OUT SMA connectors, the connections are to the
four SMA connectors to the right of the associated test ports being measured. See Figure 2
on page 9 for the connector locations.

Port 1 RCVR

e Set Test I/O addr.data 0.0

e Connect PNA Port 1 flex cable to Test Set Port 5 CPLR ARM.
¢ Connect PNA Port 2 flex cable to Test Set Port 5 RCVR OUT.
Port 3 RCVR

e  Set Test I/O addr.data 16.0

¢ Connect PNA Port 1 flex cable to Test Set Port 6 CPLR ARM.
e Connect PNA Port 2 flex cable to Test Set Port 6 RCVR OUT.
Port 4 RCVR

e Set Test I/O addr.data 32.0

e Connect PNA Port 1 flex cable to Test Set Port 7 CPLR ARM.
¢ Connect PNA Port 2 flex cable to Test Set Port 7 RCVR OUT.
Port 2 RCVR

e Set Test I/O addr.data 64.0

¢ Connect PNA Port 1 flex cable to Test Set Port 8 CPLR ARM.
e Connect PNA Port 2 flex cable to Test Set Port 8 RCVR OUT.
Port 5 RCVR

e Set Test I/O addr.data 0.16

¢ Connect PNA Port 1 flex cable to Test Set Port 5.

¢ Connect PNA Port 2 flex cable to Test Set Port 5 RCVR OUT.
Port 6 RCVR

e Set Test I/O addr.data 16.16

¢ Connect PNA Port 1 flex cable to Test Set Port 6.

e Connect PNA Port 2 flex cable to Test Set Port 6 RCVR OUT.
Port 7 RCVR

e Set Test I/O addr.data 32.16
¢ Connect PNA Port1 flex cable to Test Set Port 7.
e Connect PNA Port 2 flex cable to Test Set Port 7 RCVR OUT.
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Port 8 RCVR

¢ Set Test I/O addr.data 64.16

e Connect PNA Port 1 flex cable to Test Set Port 8.

¢ Connect PNA Port 2 flex cable to Test Set Port 8 RCVR OUT.
Port 9 RCVR

e Set Test I/0 addr.data 0.32

¢ Connect PNA Port 1 flex cable to Test Set Port 9.

¢ Connect PNA Port 2 flex cable to Test Set Port 9 RCVR OUT.
Port 10 RCVR

e Set Test I/O addr.data 16.32

e Connect PNA Port 1 flex cable to Test Set Port 10.

¢ Connect PNA Port 2 flex cable to Test Set Port 10 RCVR OUT.
Port 11 RCVR

e Set Test I/O addr.data 32.32

¢ Connect PNA Port1 flex cable to Test Set Port 11.

¢ Connect PNA Port 2 flex cable to Test Set Port 11 RCVR OUT.
Port 12 RCVR

e Set Test I/0 addr.data 64.32

e Connect PNA Port 1 flex cable to Test Set Port 12.

e Connect PNA Port 2 flex cable to Test Set Port 12 RCVR OUT.
Port 13 RCVR

e Set Test I/O addr.data 0.48

¢ Connect PNA Port 1 flex cable to Test Set Port 13

¢ Connect PNA Port 2 flex cable to Test Set RCVR OUT.
Port 14 RCVR

e Set Test I/O addr.data 16.48

e Connect PNA Port 1 flex cable to Test Set Port 14

e Connect PNA Port 2 flex cable to Test Set RCVR OUT.
Port 15 RCVR

e Set Test I/O addr.data 32.48

¢ Connect PNA Port 1 flex cable to Test Set Port 15

¢ Connect PNA Port 2 flex cable to Test Set RCVR OUT.
Port 16 RCVR

e Set Test I/O addr.data 64.48
e Connect PNA Port 1 flex cable to Test Set Port 16

e Connect PNA Port 2 flex cable to Test Set RCVR OUT.
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Port 17 RCVR

e Set Test I/O addr.data 0.64

e Connect PNA Port 1 flex cable to Test Set Port 17

¢ Connect PNA Port 2 flex cable to Test Set RCVR OUT.
Port 18 RCVR

e Set Test I/O addr.data 16.64

¢ Connect PNA Port 1 flex cable to Test Set Port 18

e Connect PNA Port 2 flex cable to Test Set RCVR OUT.
Port 19 RCVR

e Set Test I/O addr.data 32.64

e Connect PNA Port 1 flex cable to Test Set Port 19

¢ Connect PNA Port 2 flex cable to Test Set RCVR OUT.
Port 20 RCVR

e Set Test I/0 addr.data 64.64
e Connect PNA Port 1 flex cable to Test Set Port 20
e Connect PNA Port 2 flex cable to Test Set RCVR OUT.
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RF Performance Fails

If the U3042AE16 operates correctly, but RF performance fails the operational test. The
following procedures can be used to isolate the failed component. Suspect the switches
(5087-7306), RF cables, or coupler bridge (5087-7716).

NOTE The RF performance of the U3042AE16 depends on the performance of the
PNA-X. Ensure the PNA is meeting specification before continuing.

1. Verify that the test set and PNA-X SOURCE, RCVR, CPLR THRU, and CPLR ARM
connectors are clean and that the center pins are not damaged.

2. Verify the interface and internal RF cables are cleaned and not damaged.
“Troubleshooting Operational Check Failures” on page 48.

3. Review the “Operational Check” on page 40 and verify the results for the port that is
failing.

4. Reflection tracking trace shows a power hole, or is below the test limit line, perform the
switch path test for the port that is failing. Refer to “Source and Receiver Path Test” on
page 57.

5. Directivity trace fails (above —10dB), replace the coupler/bridge (5087-7716).
6. Source or load match fails (above —10 dB), replace the switch (5087-7306).

7. Isolation is poor between ports, inspect the RF connections. If it continues to fail replace
the switch (5087-7306). The RF cables require proper torque (10 in-1b) and can be
damaged by over tightening.

Control Lines are not Working

If the U3042AE16 operates correctly but the control lines are not functioning, the following
procedures can be used to verify the component failure. Suspect the DUT CONTROL BD
(E5091-66503).

1. Verify that the control voltage pins on the DUT control are connected correctly. Refer to
“DUT Control Lines” on page 32.

Verify that the control pot is centered (5V). Refer to Figure 3 on page 10.
Verify the ribbon cable connection.

Replace the DUT control board (E5091-66503).

Replace the test set control board (N5261-60006).

A
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Troubleshooting Diagrams and Tables

Table 11 Controller Board Connections

ControllerBoard | Connection
Connection

LED Ribbon Cables From the LED Board

J5 Ports 5,9, 13 and 17
J6 Ports 6, 10, 14 and 18
J7 Ports 7, 11, 15 and 19
J8 Ports 8, 12, 16 and 20
Wire harness Active LED
J16 Active LED
DUT Control Ribbon Cable
J9 DUT Controller Board

Power Supply Wire Harness

J10- 14 Power Supply

Table 12 Interface Board Connections

Switc]l;oI::srface Switches
Source and Receiver
ERULEHES Top Bottom Top Bottom

Switches | Switches Switches Switches
Ports 5, 9, 13 and 17 (Source) J13 J12 SW9 SW1
Ports 5, 9, 13 and 17 (Receiver) J7 J10 SW10 SW2
Ports 6, 10, 14 and 18 (Source) J21 J20 SW11 SW3
Ports 6, 10, 14 and 18 (Receiver) J19 J18 SW12 SW4
Ports 7, 11, 15 and 19 (Source) J29 J28 SW13 SW5
Ports 7, 11, 15 and 19 (Receiver) J27 J26 SW14 SW6
Ports 8, 12, 16 and 20 (Source) J37 J36 SW15 SW7
Ports 8, 12, 16 and 20 (Receiver) J35 J34 SW16 SW8
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Figure 44 Top View

Source and Receiver Path Test
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Figure 45 Bottom View
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Safety and Regulatory Information

Introduction

Review this product and related documentation to familiarize yourself with safety
markings and instructions before you operate the instrument. The documentation contains
information and warnings that must be followed by the user to ensure safe operation and
to maintain the product in a safe condition.

Safety Earth Ground

WARNING This is a Safety Class I product (provided with a protective earthing ground
incorporated in the power cord). The mains plug shall be inserted only into
a socket outlet provided with a protective earth contact. Any interruption
of the protective conductor, inside or outside the product is likely to make
the product dangerous. Intentional interruption is prohibited.

CAUTION Always use the three prong AC power cord supplied with this product. Failure
to ensure adequate earth grounding by not using this cord may cause product

damage and the risk of electrical shock.

Declaration of Conformity

A copy of the Declaration of Conformity is available upon request, or a copy is available on
the Agilent Technologies web site at
http:/ | regulations.corporate.agilent.com / DoC/ search.htm

Statement of Compliance

This instrument has been designed and tested in accordance with CAN/CSA 22.2
No. 61010-1-04, UL Std. 61010-1 (2nd Edition), and IEC 61010-1 (Second Edition).
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Before Applying Power

Verify that the premises electrical supply is within the range of the instrument. The
instrument has an autoranging power supply.

WARNING If this product is not used as specified, the protection provided by the
equipment could be impaired. This product must be used in a normal
condition (in which all means for protection are intact) only.

CAUTION The Mains wiring and connectors shall be compatible with the connector used
in the premise electrical system. Failure, to ensure adequate earth grounding
by not using the correct components may cause product damage, and serious
injury.

CAUTION This product is designed for use in Installation Category II and Pollution
Degree 2.

CAUTION Before switching on this instrument, make sure the supply voltage is in the
specified range.

CAUTION Verify that the premise electrical voltage supply is within the range specified
on the instrument.

CAUTION Ventilation Requirements: When installing the instrument in a cabinet,
the convection into and out of the instrument must not be restricted. The
ambient temperature (outside the cabinet) must be less than the maximum
operating temperature of the instrument by 4 °C for every 100 watts
dissipated in the cabinet. If the total power dissipated in the cabinet is
greater than 800 watts, forced convection must be used.

CAUTION This instrument has auto-ranging line voltage input, be sure the supply
voltage is within the specified range.
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Servicing

WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended. Discard used batteries according to
manufacturer’s instructions.

WARNING These servicing instructions are for use by qualified personnel only. To
avoid electrical shock, do not perform any servicing unless you are
qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose the user to
dangerous voltages. Disconnect the instrument from all voltage sources
before opening.

WARNING No operator serviceable parts inside. Refer servicing to qualified personnel.
To prevent electrical shock, do not remove covers.

WARNING The detachable power cord is the instrument disconnecting device. It
disconnects the mains circuits from the mains supply before other parts of
the instrument. The front panel switch is only a standby switch and is not a
LINE switch (disconnecting device).

WARNING The power cord is connected to internal capacitors that may remain
live for 5 seconds after disconnecting the plug from its power supply.

Connector Care and Cleaning Precautions

Remove the power cord to the instrument. To clean the connectors use alcohol in a well
ventilated area. Allow all residual alcohol moisture to evaporate, and fumes to dissipate
prior to energizing the instrument.

WARNING To prevent electrical shock, disconnect the Agilent Technologies U3042AE16
from mains electrical supply before cleaning. Use a dry cloth or one slightly
dampened with water to clean the external case parts. Do not attempt to
clean internally.

WARNING If flammable cleaning materials are used, the material shall not be stored,
or left open in the area of the equipment. Adequate ventilation shall be
assured to prevent the combustion of fumes, or vapors.
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Electrostatic Discharge Protection

Protection against electrostatic discharge (ESD) is essential while removing assemblies
from or connecting cables to the instrument. Static electricity can build up on your body
and can easily damage sensitive internal circuit elements when discharged. Static
discharges too small to be felt can cause permanent damage. To prevent damage to the
instrument:

always have a grounded, conductive table mat in front of your test equipment.

always wear a grounded wrist strap with grounding cord, connected to a grounded
conductive table mat, having a 1 MQ resistor in series with it, when handling
components and assemblies or when making connections.

always wear a heel strap (9300-1126) when working in an area with a conductive floor.
If you are uncertain about the conductivity of your floor, wear a heel strap.

always ground yourself before you clean, inspect, or make a connection to a
static-sensitive device or test port. You can, for example, grasp the grounded outer shell
of the test port or cable connector briefly.

always ground the center conductor of a test cable before making a connection to the
analyzer test port or other static-sensitive device. This can be done as follows:

1. Connect a short to one end of the cable to short the center conductor to the outer
conductor.

2. While wearing a grounded wrist strap, grasp the outer shell of the cable connector.

3. Connect the other end of the cable to the test port and remove the short from the
cable.

Figure 46 ESD Protection Setup

NOTE:

A 3-Wire line

power cord with proper
connection to ground
must be used for

ESD protection

Anti-Static Mat

ku310b
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Regulatory Information

Instrument Markings

This section contains information that is required by various government regulatory
agencies.

The instruction documentation symbol. The product is marked with this symbol
when it is necessary for the user to refer to the instructions in the documentation.

This symbol indicates separate collection for electrical and electronic equipment,
mandated under EU law as of August 13, 2005. All electric and electronic equipment
are required to be separated from normal waste for disposal (Reference WEEE
Directive, 2002/96/EC).

This symbol indicates that the instrument requires alternating current (ac) input.

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in the OFF position.

This symbol is used to identify a terminal which is internally connected to the
product frame or chassis.

|
Y
(I) This symbol indicates that the power line switch is in the STANDBY position.
The CE mark is a registered trademark of the European Community. (If accompanied
<€ by a year, it is when the design was proven.)
The CSA mark is a registered trademark of the CSA International. This instrument
complies with Canada: CSA 22.2 No. 61010-1-04.

A This is a symbol of an Industrial Scientific and Medical Group 1 Class A product.

This is a marking to indicate product compliance with the Canadian
ICES/NMB-001 Interference-Causing Equipment Standard (ICES-001).

—_— Direct Current.

IP20 The instrument has been designed to meet the requirements of IP 2 0 for egress and
operational environment.

This is a required mark signifying compliance with an EMC requirement. The C-Tick
o N10149 mark is a registered trademark of the Australian Spectrum Management Agency.

n Indicates the time period during which no hazardous or toxic substance elements are

|40’ expected to leak or deteriorate during normal use. Forty years is the expected useful
life of the product.

:‘6 This symbol on all primary and secondary packaging indicates compliance to China

" standard GB 18455-2001.
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Battery Collection

Do not throw batteries away but collect as small chemical waste, or in accordance with
your country’s requirements. You may return the battery to Agilent Technologies for

disposal. Refer to “Contacting Agilent” on page 74 for assistance.

Compliance with German Noise Requirements

Regulatory Information

This is to declare that this instrument is in conformance with the German Regulation on
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung-3.

GSGV Deutschland).
Acoustic Noise Emission/Geraeuschemission
LpA<70 dB Lpa<70 dB
Operator Position am Arbeitsplatz

Normal Operation

normaler Betrieb

per ISO 7779

nach DIN 45635t .19

EMC Information

Complies with European EMC Directive 2004/108/EC

e JEC/EN 61326-1
e CISPR Pub 11 Group 1, class A
e AS/NZS CISPR 11

e This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB du Canada.
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Agilent Support, Services, and Assistance

Service and Support Options

The standard product warranty is a one-year return to Agilent Technologies service
warranty.

NOTE There are many other repair and calibration options available from the
Agilent Technologies support organization. These options cover a range of
service agreements with varying response times. Contact Agilent for
additional information on available service agreements for this product.

Contacting Agilent

Assistance with test and measurements needs and information or finding a local Agilent
office are available on the Web at:
http:/ lwww.agilent.com /find / assist

If you do not have access to the Internet, contact your field engineer.

NOTE In any correspondence or telephone conversation, refer to the Agilent product
by its model number and full serial number. With this information, the
Agilent representative can determine the warranty status of your unit.

Shipping Your Product to Agilent for Service or Repair

IMPORTANT Agilent Technologies reserves the right to reformat or replace the internal
hard disk drive in your analyzer as part of its repair. This will erase all user
information stored on the hard disk. It is imperative, therefore, that you
make a backup copy of your critical test data located on the analyzer’s hard
disk before shipping it to Agilent for repair.

If you wish to send your instrument to Agilent Technologies for service or repair:

¢ To improve turn-around time, send your PNA-X and cables to Agilent to verify
operation of the complete system.

¢ Include a complete description of the service requested or of the failure and a
description of any failed test and any error message.

¢ Remove and retain the front handles and all rack mount hardware. The analyzer should
be sent to Agilent in the same configuration as it was originally shipped.

e Ship the analyzer using the original or comparable antistatic packaging materials.

¢ Contact Agilent for instructions on where to ship your analyzer.
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